
Guía del BSO – Año Tributable 2011                          Servicio de verificación del número de Seguro Social 

(SSNVS) 

 

Guía del BSO para el año tributable 2011 

 

 

Servicio de verificación de 

números de Seguro Social 

(SSNVS, siglas en inglés) 

 
Contiene las siguientes lecciones: 

 

Cómo pedir una verificación de números de Seguro Social por 

Internet 

Cómo presentar un archivo electrónico para verificación de 

números de Seguro Social 

Cómo ver información de estado de la presentación y 

recuperación 

Cómo ver el manual de Servicio de verificación de número de 

Seguro Social 

 

 
LECCIÓN 1: CÓMO PEDIR VERIFICACIÓN DE UN 

NÚMERO DE SEGURO SOCIAL POR INTERNET 

 
Los usuarios registrados (empleadores y ciertos terceros partidos) pueden verificar hasta 10 

nombres y números de Seguro Social (SSN, siglas en inglés para el número de Seguro 

Social) por Internet y recibir resultados inmediatos. 

 



NOTA:  
Para obtener acceso al Servicio de verificación de número de Seguro Social 

(SSNVS) los usuarios deben inscribirse con el « Integrated Registration 

Services» (Servicio de inscripción integrado – IRES, siglas en inglés) 

primero y recibir un número de identificación de usuario (User ID) y 

contraseña. 

 

Para obtener acceso al SSNVS, después de inscribirse, siga los siguientes pasos: 

 

PASO 1: Dirija su navegador a la página titulada, «Business Services Online (BSO) 

Welcome» (Bienvenido a los Servicios por Internet para Empresas – BSO, siglas en 

inglés): www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible en inglés). 

 

PASO 2: Pulse en el botón que lee, «Log In» (Ingrese) en la página titulada, «Business 

Services Online Welcome». El sistema mostrará en pantalla la página titulada, «Log 

In to Online Services» (Ingrese a nuestros servicios por Internet). 

 

 

 
 

PASO 3: Ingrese su «User ID» (Identificación de Usuario) y contraseña. 

 



PASO 4: Seleccione el encasillado que lee, «I have read & agree to these terms» (He leído y 

estoy de acuerdo con las condiciones de uso) para indicar que ha leído la declaración de 

condiciones para el usuario y que está de acuerdo con su contenido. Luego, seleccione el botón 

que lee, «Login» (Ingrese). Éste mostrará la página de Internet de BSO titulada, «Main Menu » 

(Página principal). 

 

NOTA: 

 Para regresar a la página inicial del BSO, pulse el enlace que lee «BSO 

Welcome» (Bienvenido al BSO). 

 

 
PASO 5: Seleccione el enlace que lee, «Social Security Number Verification Service» (Servicio 

de verificación de número de Seguro Social). 

 

Social Security Number Verification Service (Servicio de Verificación del 

Número de Seguro Social) 
   Request online SSN verification (solicite la verificación del número de Seguro Social por Internet), o 

    Submit files for SSN verification (envíe archivos para la verificación del número de Seguro Social) 

 

El sistema mostrará en pantalla la página de opciones de tareas titulada, «Social Security 

Number Verification Service». 

 



 
 

PASO 6: Seleccione el enlace que lee, «Request Online SSN Verification» (Solicitar 

verificación del número de Seguro Social por Internet) (Para regresar a la página principal de 

BSO, seleccione el botón que dice BSO Main Menu). 

 

Request Online SSN Verification (Solicitar Verificación del SSN por Internet)  
Ingrese manualmente y envíe hasta 10 números de Seguro Social y nombres para ser verificados por el Seguro 

Social. Los resultados se muestran inmediatamente para ser revisados. 

 

 

El sistema mostrará en pantalla la página titulada, «SSNVS Attestation» (Certificación de 

solicitud de SSNVS). 



 
 



PASO 7: Seleccione el botón que lee, «I Accept» (Acepto) para indicar que ha leido la 

declaración de condiciones para el usuario del SSNVS y que está de acuerdo con su contenido. 

Entonces el sistema mostrará la página de SSN Verification (Verificación del número de Seguro 

Social). (Para regresar a la página principal del BSO, pulse en el botón que lee I DO NOT Accept 

(No acepto). 

 

 



 

PASO 8: En el encasillado que lee, «Employer’s EIN» (Número de identificación del 

empleador), ingrese el EIN del empleador bajo el cual está informando los salarios para los 

nombres y números de Seguro Social que está verificando. Llene una (1) fila por cada nombre y 

número de Seguro Social que desea verificar. Debe llenar todos los encasillados requeridos en 

por lo menos una (1) fila antes de seleccionar el botón que lee, «Submit» (Presentar). 

 

NOTA: 

Los espacios que debe llenar para el EIN, número de Seguro Social, nombre y apellido del 

empleador, son obligatorios. 

Los espacios designados para el «Middle Name» (segundo nombre), «Suffix» (sufijo), «Date 

of Birth» (fecha de nacimiento, DOB, siglas en inglés) y «Gender»(género) son opcionales. 

 

PASO 9: Seleccione el botón que lee «Submit» (Presentar) para procesar la información. (De lo 

contrario, seleccione el botón que lee, «Clear Form» (suprimir el formulario) para borrar toda la 

información. El sistema mostrará los resultados de la página titulada, «SSN 

Verification Results» (Resultados de la verificación de números de Seguro Social). 

 

 



 

Esta página mostrará: 

Opciones de tareas a la mano izquierda - Número de identificación del 

empleador (EIN), el número total de registros presentados, el número total 

de verificaciones que no se pudieron procesar, el número total de personas 

fallecidas y el número total de registros verificados. 

 

Resto de la pantalla – La información presentada por el usuario junto con 

los códigos que explican los resultados. 

 

NOTA: 
Si ocurren problemas con esta verificación, el sistema mostrará la página 

titulada, «Convert to Batch» (Convertir en lote para procesarlos). Seleccione el 

botón que lee, «Overnight» (de un día para otro) y el Seguro Social procesará 

su pedido y le enviará los resultados dentro de dos (2) días laborables. Para 

obtener más información, siga las instrucciones en la LECCIÓN 2: Cómo 

presentar un archivo electrónico para verificación del número de Seguro Social. 

 

PASO 10: El número de Seguro Social (SSN) presentado para verificación concuerda con los 

registros del Seguro Social. 

 

El usuario verá un «-» en el campo de «Verification Results» (resultados de 

verificación). 

 

NOTA: 

Por razones de seguridad, si el registro tiene un resultado de verificación de 

«-», los primeros cinco (5) números del Seguro Social se ocultarán con una 

«X». 

 

PASO 11: El número de Seguro Social «SSN» presentado para verificación concuerda 

con los registros del Seguro Social pero nuestros registros indican que la 

persona ha fallecido. 

 

El usuario verá la palabra «Deceased» (fallecido) en la columna de resultados 

y un «-» en la columna que lee, «Verification Results» (resultados de 

verificación). 

 

PASO 12: Si algunos números de Seguro Social no pudieron ser verificados, el número 

en la columna que lee, «Verification Results» mostrará la razón por qué no 

se pudo verificar. 

 

Los siguientes códigos describen los resultados de verificación que han fallado: 

 

1   El número de Seguro Social no se encuentra en nuestros registros (nunca 

se emitió). 

2   El nombre concuerda; la fecha de nacimiento no concuerda. 



 

3   El nombre no concuerda; no se verificó la fecha de nacimiento. 

 

4   El número de Seguro Social no verificó; otra razón. 

 

NOTA: 

Por razones de seguridad, si el registro tiene un resultado de verificación con 

códigos de 2 ó 4, los primeros cinco (5) números del Seguro Social se 

ocultarán con una «X». 

 

Si la información no concuerda con los registros del Seguro Social, seleccione 

el enlace que lee, «What to do if an SSN fails to verify» (Qué hacer si los 

nombres o números de Seguro Social no concuerdan) para ver una 

información importante. 

 

PASO 13: Pulse en el enlace que lee, «Verify More SSNs» para verificar otros números de 

Seguro Social. (Para regresar a la página de opciones de tareas del BSO, seleccione 

el enlace que lee, «BSO Main Menu.) 

 

 



LECCIÓN 2: CÓMO PRESENTAR UN REGISTRO EN 

FORMATO ELECTRÓNICO PARA VERIFICACIÓN DE LOS 

NÚMEROS DE SEGURO SOCIAL 

 
Siga las instrucciones a continuación para subir un registro que contiene los nombres y números 

de Seguro Social para ser verificados por la Administración del Seguro Social. Por lo general, los 

resultados están disponibles el próximo día laborable del gobierno. 

 

PASO 1: Dirija su navegador a la página de Internet titulada, «Business Services Online 

Welcome» (Bienvenido a los servicios por Internet para empresas): 

www.segurosocial.gov/bso/bsowelcome.htm. (Sólo disponible en inglés.) 

 

PASO 2: Seleccione el botón que lee, «Log In» (Ingrese) en la página de bienvenida de BSO. El 

sistema mostrará en pantalla la página titulada, «Log In to Online Services page» (Ingrese al 

BSO). 

 

 
 

PASO 3: Ingrese su «User ID» (número de identificación del usuario) y contraseña. 

 

PASO 4: Seleccione el encasillado que lee, «I have read & agree to these terms» (He leido y 

acepto las condiciones de uso) para indicar que ha leído la declaración de condiciones para el 

usuario y está de acuerdo con lo que dice. Pulse en el botón que lee, «Log In». (Para regresar a 

la página inicial del BSO, pulse en el enlace que lee, «BSO Welcome». El sistema mostrará en 

pantalla la página de opción de tareas titulada, «Main Menu». 



 
 

PASO 5: Seleccione el enlace titulado, «Social Security Numbers Verification Service» 

(Servicio de verificación de números de Seguro Social). 

 

Social Security Number Verification Service (Servicio de Verificación del 

Número de Seguro Social) 
   Request online SSN verification (solicite la verificación del número de Seguro Social por Internet), o 

  Submit files for SSN verification (envíe archivos para la verificación del número de Seguro Social 

 

El sistema mostrará en pantalla la página de opciones de tareas titulada, «Social Security 

Numbers Verification Service» (Servicio de verificación del número de Seguro Social). 



 
PASO 6: Seleccione el enlace que lee, «Submit an Electronic File for SSN Verification» 

(Presentar un registro electrónico para verificación del número de Seguro Social). 

 

(Para regresar a la página de opciones de tareas del BSO titulada, «Main Menu», pulse en el 

botón que lee, «BSO Main Menu». 

 

Submit an Electronic File for SSN Verification (Presentar un registro 

electrónico para verificación del número de Seguro Social) 
Presente un registro que contiene los nombres y números de Seguro Social para ser verificados por el Seguro 

Social. La información en el registro debe estar en el format correcto. 

 

El sistema mostrará en pantalla la página titulada, «SSNVS Attestation» (confirmación del 

SSNVS). 

 



 
 



PASO 7: Seleccione el botón que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, «SSNVS Attestation». El sistema mostrará en pantalla la página 

titulada «Submit a File for SSN Verification – Before You Start » (Presentar un registro 

electrónico para verificación del número de Seguro Social – Antes de que comience). 

(Para regresar a la página de opciones de tareas, pulse en el botón que lee, «I DO NOT Accept» 

(No Acepto). 

 

 
PASO 8: Seleccione el botón que lee, «Continue» (Continuar) después de leer la información en 

la página titulada, «Submit a File for SSN Verification – Before You Start». El sistema mostrará 

en pantalla la página titulada, «Submit a File for SSN Verification – Submit Your File» (Presente 

un registro para verificación del número de Seguro Social – Presente su registro). 

 

 (Para regresar a la página de opciones de tareas, pulse en el botón que lee, «BSO Main Menu».) 

 



 
 

PASO 9: Ingrese el número de identificación del empleador (EIN) bajo el cual se están 

informando los salarios para los nombres y números de Seguro Social que se están verificando. 

Si sabe el nombre del registro que quiere subir, escriba el nombre del archivo en el encasillado 

que lee, «Select file» (seleccione el registro) o seleccione un registro de su directorio o red local 

pulsando en el botón que lee, «Browse» (ojear). 

 

Consejos: 
El registro no debe contener más de 250,000 pedidos de verificación de números de Seguro 

Social. 

 

Si tiene más de 500 pedidos de verificación de números de Seguro Social o tiene una 

conexión de Internet lenta, recomendamos que comprima su registro usando el WinZip, PKZIP, 

u otro programa de comprimir compatible. 

 

PASO 10: Seleccione el botón que lee, «Submit» (Presentar). Aparecerá en pantalla una 

ventanilla que leerá, «File Upload in process…» (procedimiento en progreso). 

 



 
 

Una vez que el archivo se haya trasferido, el sistema mostrará la página de confirmación titulada 

«Submit a File for SSN Verification – Confirmation». 

 

 
 

Consejos:  

Asegúrese de anotar el número de confirmación. Lo necesitará para mantenerse al día de lo que 

está sucediendo con el registro que presentó. 

 

PASO 11: Seleccione el botón que lee, «OK» en la ventanilla que aparecerá en pantalla para 

imprimir la página de confirmación titulada, «Submit a File for SSN Verification – 

Confirmation». 



 
 

De lo contrario, seleccione el botón que lee, «Cancel» (cancelar) para cerrar la ventanilla. 

 

PASO 12: Seleccione el botón que lee, «Submit Another File» (presente otro registro) para 

presentar otro registro o pulse en el botón que lee, «BSO Main Menu» para regresar a la página 

de opción de tareas del BSO. 



 

 

LECCIÓN 3: CÓMO VER EL ESTADO DEL REGISTRO E 

INFORMACIÓN SOBRE EXTRACCIÓN DEL MISMO 

 
Siga las siguientes instrucciones para ver el estado actual de los registros electrónicos 

presentados para que se procesen de un día para otro. 

 

PASO 1: Dirija su navegador de Internet a la página inicial del BSO titulada, «BSO Welcome» 

(Bienvenido a los Servicios por Internet para empresas): 

www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible en inglés). 

 

PASO 2: Seleccione el botón que lee, «Log In» (Ingrese). El sistema mostrará en pantalla la 

página titulada, «Log In to Online Services» (ingrese al BSO). 

 

 
 

PASO 3: Ingrese su «User ID» (identificación del usuario) y contraseña. 

 

PASO 4: Seleccione el encasillado que lee, «I have read & agree to these terms» (He leído y 

acepto las condiciones de uso) para indicar que ha leído la declaración de condiciones para el 

usuario y está de acuerdo con lo que dice. Pulse en el botón que lee, «Log In». (Para regresar a la 

página inicial del BSO, seleccione el enlace que lee, «BSO Welcome». El sistema mostrará en 

pantalla la página de opción de tareas titulada, «Main Menu».) 

 



 
 

PASO 5: Seleccione el enlace titulado, «Social Security Numbers Verification Service» 

(Servicio de verificación de números de Seguro Social). 

 

Social Security Number Verification Service (Servicio de Verificación del 

Número de Seguro Social) 
   Request online SSN verification (solicite la verificación del número de Seguro Social por Internet), o 

  Submit files for SSN verification (envíe archivos para la verificación del número de Seguro Social. 
 

El sistema mostrará en pantalla la página de opciones de tareas titulada, «Social Security 

Number Verification Service» (Servicio de verificación del número de Seguro Social). 

 



 
 

 

PASO 6: Pulse en el enlace que lee, «View Status and Retrieval Information» (Ver el estado 

del registro e información sobre la extracción del mismo).  

 

(Para regresar a la página de opción de tareas titulada, «Main Menu», pulse en el botón que lee, 

«BSO Main Menu ».) 

 

View Status and Retrieval Information (Ver el Estado del Registro e información del mismo)       

Vea el estado actual del registro presentado. 

 

El sistema mostrará en pantalla la página titulada, «SSNVS Attestation»(Certificación del uso 

del sistema SSNVS). 

 



 
 



PASO 7: Seleccione el botón que lee, «I Accept» (Acepto) después de leer las condiciones 

definidas en la página titulada, « SSNVS Attestation». El sistema mostrará en pantalla la página 

titulada, «Status and Retrieval» (Estado y extracción del registro). (Para regresar a la página de 

opciones de tareas del BSO, seleccione el botón que lee, «I DO NOT Accept» (No Acepto). 

 

 
PASO 8: Seleccione una de las siguientes opciones para ver el estado del registro que presentó. 

 

Opción 1: Ingrese el número de rastreo específico o número de confirmación para ver el estado 

de un registro individual. 

 

Opción 2: Ingrese una fecha de comienzo y final para ver el estado de los registros presentados 

dentro de un periodo de tiempo. 

 

Opción 3: Vea los 100 registros más recientes de SSNVS presentados y que están asociados con 

su «User ID» (Identificación de usuario). 

 

Consejos: 

 Si el sistema no muestra el registro que busca, concentre su búsqueda usando 

las opciones 1 ó 2. 

 



PASO 9: Seleccione el botón que lee, «Submit» (Presentar) correspondiente. El sistema 

mostrará en pantalla la página titulada, «Status and Retrieval Results» (Resultados 

de estado y extracción). 

 

PA

SO 10: Las opciones de estado y extracción aparecen en formato de tabla; para ver 

una explicación completa de cada columna, pulse en el encabezamiento de 

la columna. Esto abrirá una nueva página en su navegador titulada, «SSNVS 

Help» (Ayuda con SSNVS), la cual sólo es accesible si ingresa al SSNVS. 

 

Pulse en el enlace que lee, «Download/View» (Descargar o Ver [el registro]) en la 

columna titulada, «Retrieval Option(s)» (Opciónes de extracción) para ver los 

resultados. 

 

NOTA: 
Si presenta menos de 10 números de Seguro Social, puede 

descargar los resultados o verlos en pantalla. 

 

Si presenta más de 10 números, no podrá verlos en pantalla, 

tendrá que descargarlos. 

 

PASO 11: Seleccione el enlace en el encabezamiento de la columna titulada, «Status» (Estado 

[del 

registro]) para informarse mejor sobre el estado del registro presentado, si aplica. 



 

NOTA: 
 

 

La columna titulada, «Available Through» (Disponible hasta) 

establece hasta qué fecha el estado y resultados están disponibles 

para que el usuario las vea. 

 

Los usuarios pueden ver o descargar los resultados por 30 días 

desde el día que la información estuvo disponible. 

 

Después de 30 días, y hasta 2 años más tarde, los usuarios sólo 

pueden ver el estado de sus registros. 

 

Durante el periodo en que los registros están disponibles, no hay 

cantidad límite en las veces que los usuarios pueden descargar o 

verlos. 

 



LECCIÓN 4: CÓMO VER EL MANUAL DEL SSNVS 

 
El manual del SSNVS se puede ver al ingresar por Internet al programa de SSNVS o al pulsar en 

los enlaces en el «SSNVS Handbook» (Manual del SSNVS), versión electrónica, que se 

encuentran a continuación. (sólo disponible en inglés.) 

 

En la página inicial del BSO – http://www.segurosocial.gov/bso/ 

 

En la página de noticias del SSNVS News – 

www.segurosocial.gov/employer/ssnvsNews.htm 

 

La página de información e instrucciones del SSNVS – 

www.segurosocial.gov/employer/ssnv.htm#overview 

 

Para ingresar al manual del SSNVS desde el programa SSNVS, siga las siguientes instrucciones. 

 

PASO 1: Dirija su navegador a la página de Internet titulada, «BSO Welcome» (Bienvenido a 

los Servicios por Internet para empresas): www.segurosocial.gov/bso/bsowelcome.htm (sólo 

disponible en inglés). 

 

PASO 2: Seleccione el enlace que lee, «Log In» (Ingrese). El sistema mostrará en pantalla la 

página titulada, «Log In to Online Services» (Ingrese a los servicios por Internet). 

 

 
 

PASO 3: Ingrese su «User ID» (identificación del usuario) y contraseña. 

 

PASO 4: Seleccione el encasillado que lee, «I have read & agree to these terms» (He leído y 

acepto las condiciones de uso) para indicar que ha leído la declaración de condiciones para el 

usuario y está de acuerdo con lo que dice. Seleccione el botón que lee, «Log In». (Para regresar 

http://www.segurosocial.gov/bso/
http://www.segurosocial.gov/employer/ssnvsNews.htm
http://www.segurosocial.gov/employer/ssnv.htm#overview


a la página inicial del BSO, pulse en el enlace que lee, «BSO Welcome»). El sistema mostrará 

en pantalla la página de opción de tareas titulada, «Main Menu». 

 

 
PASO 5: Seleccione el enlace que lee, «Social Security Number Verification Service» 

(Servicio de verificación de los números de Seguro Social). 

 

Social Security Number Verification Service (Servicio de Verificación del 

Número de Seguro Social) 
   Request online SSN verification (solicite la verificación del número de Seguro Social por Internet), o 

   Submit files for SSN verification (envíe archivos para la verificación del número de Seguro Social. 
 

El sistema mostrará en pantalla la página de opciones de tareas del Servicio de verificación de 

números de Seguro Social. 



 
PASO 6: Seleccione el enlace que lee, «View Social Security Number Verification Service 

(SSNVS) Handbook» (Ver el manual del Servicio de verificación del número de Seguro Social). 

(Para regresar a la página principal del BSO, seleccione el botón que lee BSO Main Menu.) 

 

Ver el Manual del Servicio de Verificación del Número de Seguro Social 
Revise la información adicional acerca de cómo presentar registros al Seguro Social para ser verificados y para 

extraer los resultados de las verificaciones. 
 

El sistema mostrará en pantalla el manual del SSNVS. 



 
 

 

 

 
 


